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How we look and how we sound says 
a lot about who we are and what we 
stand for. In this booklet, you’ll find 
everything you need to look, sound and 
feel like Queen Mary Students’ Union.

We strive to be fun and welcoming to all our 
students, and these guidelines are designed to help 
you get to grips with everything that makes up our 
identity and to help you use our brand. 
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Who are we?
Queen Mary Students’ Union 
is a vibrant community of 
over 15,000 students, run 
by four elected Executive 
Officers and around 45 student 
representatives. 

By listening to what students want, we use 
the money made in our Sport and Fitness 
Centre, shops, bars and cafés, to support 
our student services, clubs and societies. 
Our mission is that together, we improve 
students’ lives and our brand ties all of 
this together.

What is our brand?

Our brand is more than just our logo. 

Our brand represents everything we do in 
our organisation, from our name to how 
we sound, look and behave.

Our values

Our brand is guided by our mission, vision 
and values. These values are the core 
of our brand and are at the centre of 
everything we do as a Students’ Union. 

Our Mission
Together,  
we improve 
students’ lives

Our Vision
We want to be 
at the heart 
of the student 
experience

Our Values
  Student-led 
  Democratic
  Transparent

  Supportive
  Inclusive 
  Accessible

  Welcoming
  Fun
  Committed
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1.1

Our Logo
We are Queen Mary Students’ Union and we 
want people to know who we are and what we 
do. We can do this by ensuring the Students’ 
Union logo is on everything we produce.

Sending to a third party

If you need a logo to send onto a third party/
external supplier/merchandise printer please 
talk to a member of the Communications 
and Marketing team, who will discuss how 
it should be used (minimum sizes, widths, 
colours and so on) and provide a copy of 
our visual guidelines to ensure that it is used 
correctly by external suppliers.

Download

Our logo is not available to download as our 
downloadable templates already include the 
logo and the Communications and Marketing 
team will produce any specialist print 
materials you need.

Older versions

Some older documents may include an old 
version of our logo. If you spot any, please 
let the Communications and Marketing team 
know and they will update it for you. Some old 
versions of the logo contain a comma after 
Queen Mary.

Editing the logo

Never change any element of the logo, 
including the colour, the scale or the font. It 
should always appear exactly as it appears 
here.
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1.2

Our Logo  
for designers 
Design documents

In nearly all our design production, the 
logo will be either a solid black or white 
colour, determined by the media they are 
applied to. The logo can be used over 
imagery as long as legibility is retained. 

In some instances, the logo can also be 
featured in one of our brand colours at 
the discretion of the Communications 
and Marketing team. This allows design 
flexibility when necessary.
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1.3

Logo usage 
for staff 
Never change any element of the logo 
(colour, scale, fonts) it should always 
appear exactly as it is provided.

Never do the following

Our Logo

Remove or add anything Change the dimensions Change the colours or fonts

Students’ Union
Volunteering
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1.4

Logo usage 
for designers 
Guidelines

These guidelines show you how the logo 
should be used with partner logos, the 
exclusion zone and minimum size for 
production.

Exclusion zone

Always leave the logo some space to 
breathe. We’ve defined an exclusion 
zone based o the leopard head to 
stop other graphic elements or text 
from interfering with the logo.

Minimum size

For the identity format there are minimum size 
requirements which must be adhered to when 
specifying for print production and online usage. 
This is important to ensure the legibility of the logo. 
This does not apply to merchandise. 

40mm / 150px

Partner logos

When working in partnership with external brands or 
the university their logos are placed on the left hand 
side outwards opposite the Students’ Union logo.

Logo Logo Logo
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1.5

Logo Position 
and Size for 
designers
Position

Ideally, the logo will always appear at the 
bottom right of any artwork we produce. 
If the design is centred then the logo may 
appear centred on the artwork too.

Size

The ideal sizes are defined on the right. 

Design templates

There are a range of design templates 
produced as a starting point for all our 
designs.

A6

A5

A4

A3

A6

Logo width = 39mm

Space = 4.5mm

A5

Logo width = 55mm

Space = 6mm

A4

Logo width = 78mm

Space = 8.5mm

A3

Logo width = 110mm

Space = 12mm
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1.6

Organisational 
Font for staff 
Century Gothic

Our organisation-wide font is Century 
Gothic and is used for all documents 
produced outside the Communications 
and Marketing Team. There are templates 
on www.qmsu.org/communications/
brand for advice on how to lay out 
documents.

Century Gothic Regular

Century Gothic Regular italic

Century Gothic Bold
Century Gothic Bold italic

Century Gothic



How we look 11

1.7

Fonts for 
designers
The Students’ Union has two 
fonts for design use: Cocogoose 
and Proxima Nova. These 
are paid fonts with copyright 
licences and are not available to 
all staff.

Cocogoose (Titles)

The Cocogoose typeface has many fonts 
in different weights and styles and is 
used in all artwork produced for Queen 
Mary Students’ Union. Titles in design 
documents should use one of the fonts 
from the Cocogoose font family.

Proxima Nova (Body)

The Proxima Nova typeface has many 
fonts in different weights and styles. Any 
body text in design documents should use 
the following four fonts for better legibility.

Cocogoose Light Italic

Cocogoose Thin

Cocogoose Thin italic

Cocogoose UltraLight

Cocogoose UltraLight Italic

Cocogoose Light

Cocogoose SemiLight Italic

Cocogoose Letterpress

Cocogoose SemiLight

Cocogoose Inline

Cocogoose Outlined

Cocogoose Regular
Cocogoose Italic

Cocogoose Block Border
Cocogoose Block Gradient
Cocogoose Block Innerline
Cocogoose Block Shadow

Cocogoose

Proxima Nova Alt Regular

Proxima Nova Alt Regular Italic

Proxima Nova Alt Bold

Proxima Nova Alt Bold italic

Proxima Nova

Cocogoose Light Italic

Cocogoose Thin

Cocogoose Thin italic

Cocogoose UltraLight

Cocogoose UltraLight Italic

Cocogoose Light

Cocogoose Italic
Cocogoose Letterpress

Cocogoose SemiLight

Cocogoose Semi Light Italic

Cocogoose Regular

C. Condensed

Cocogoose Light Italic

Cocogoose Thin

Cocogoose Thin italic

Cocogoose UltraLight

Cocogoose UltraLight Italic

Cocogoose Light

Cocogoose Italic
Cocogoose Bold

Cocogoose SemiLight

Cocogoose Semi Light Italic

Cocogoose Regular

C. Compressed

Cocogoose Letterpress
Cocogoose Bold Italic

Cocogoose Light Italic

Cocogoose Thin

Cocogoose Thin italic

Cocogoose UltraLight

Cocogoose UltraLight Italic

Cocogoose Light

Cocogoose Italic
Cocogoose Letterpress

Cocogoose SemiLight

Cocogoose Semi Light Italic

Cocogoose Regular

C. Narrow
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1.8

Our brand 
colour 
Our blue

This is our main organisational colour.  
It should be used in all official documents 
and presentations.

External printers & suppliers

Sometimes when you order specialist print 
materials or work with external designers 
or developers you may be asked to 
provide a specific colour reference. Here’s 
a handy guide of when to supply which 
references:

CMYK

All print materials 

RGB

Screens / Presentations

Hex colour

Web developers

Pantone

Specialist and high-end print materials 
which match the colour exactly. 
Usually comes at an additional cost.

Pantone 2728

CMYK - 96/72/0/0

RGB - 0/71/186

Hex colour - #0047ba
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CMYK - 40/0/26/0
RGB - 166/214/202
#A6D6CA

Pantone 2464 C/U
CMYK - 47/01/69/0
RGB - 154/198/112
#9AC670

CMYK - 42/0/1/0
RGB - 156/215/246
#9CD7F6

CMYK - 96/52/0/0
RGB - 0/105/179
#0069B3

1.9

Our Colour 
Scheme 
We are a diverse, fun, and 
creative organisation and we 
want our colours to reflect this.

We offer many different services, 
opportunities and activities to students, 
including events, volunteering 
opportunities, shops, bars, student groups, 
and a variety of places and spaces. We’re 
not limited to what we offer so we don’t 
want our colours to be limited either.

We will always give priority to our 
organisational colour blue; however, other 
colours may be used to complement our 
identity.

Each outlet and venue has it’s own set of 
colours from the palette outlined in the 
sub-brand section.

Pantone 298C/U

CMYK - 69/1/0/0

RGB - 33/187/238

#21BBEE

CMYK - 81/41/73/42
RGB - 43/85/64

#2B5540

CMYK - 47/18/84/3
RGB - 153/171/72

#99AB48

Pantone 311C/U
CMYK - 72/0/13/0

RGB - 0/183/217
#00B7D9

Pantone 648C/U
CMYK - 100/77/33/21

RGB - 18/61/103
#123D67

CMYK - 1/50/4/0
RGB - 241/158/191
#F19EBF

Pantone 268C/U
CMYK - 82/98/0/12

RGB - 81/36/122
#51247A

CMYK - 24/85/5/0
RGB - 195/66/140

#C3428C

CMYK - 18/100/43/8
RGB - 190/18/84

#BE1254

Pantone Warm Red C/U
CMYK - 0/85/76/0

RGB - 232/66/57
#E84239

CMYK - 17/38/87/5
RGB - 210/157/51

#D29D33

CMYK - 42/54/0/0
RGB - 163/130/186
#A382BA

CMYK - 0/56/35/0
RGB - 242/141/141
#F28D8D

CMYK - 0/44/47/0
RGB - 245/166/133
#F5A685

Pantone 143C/121U
CMYK - 0/32/87/0
RGB - 250/183/45
#FF9E1B

Pantone 3252U/C

CMYK - 67/0/33/0

RGB - 21/202/195

#15CAC3

Pantone 258

CMYK - 58/91/0/0

RGB - 134/52/139

#86348B

Pantone 2039

CMYK - 9/91/10/1

RGB - 217/48/122

#D9307A

Pantone 109C

CMYK - 0/25/95/0

RGB - 253/196/0

#FDC400

Primary colours Secondary Dark

Pantone 1375C / 136U

CMYK - 0/43/87/0

RGB - 255/158/27

#FF9E1B

Secondary Light

Main colour

Pantone 2728

CMYK - 96/72/0/0

RGB - 0/71/186

Hex colour - #0047ba

CMYK - 92/50/23/4
RGB - 0/106/151

#006A97

CMYK - 100/21/23/3
RGB - 0/134/174
#0086AE
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1.10

Photography 
Photography is a powerful way 
to communicate our unique 
brand identity.

Be professional

Wherever possible, use professionally 
taken photography. If you require 
photography for a project, it is important 
to make sure you’ve budgeted for this 
in advance. If you require the use of a 
Student Photographer, make sure you 
request this from the Communications and 
Marketing team.

Copyright

If you have found a suitable image online, 
make sure you have the legal right to 
use it. You may only use an image found 
online or through Google if it clearly 
states it is for public non-commercial use.

Quality

Our Student Photographers produce a 
range of high-quality images that are 
suitable for all print uses. If you find an 
image online then the quality may not be 
high enough for print use and will look 
blurry. The Design team will be able to 
advise you but as a rough guide, check 
the file size is above at least 1000kb, If it 
has come from Facebook or social media, 
the image will be too small for print. 

Style

Try to ensure photos look natural and 
not staged. Hiring Student Photographers 
to capture your events is a great way of 
ensuring we have a range of photos of 
real-life students engaged in what we do 
and will make promotion of your future 
projects a lot easier! 

Treatment

Make sure your images are the correct 
size for what you need them for. Do not 
stretch the image out of proportion and 
always use high-quality images when 
creating social media posts. 

Keep our values in mind

Any image you use should reflect our 
values and be appropriate for what you’re 
trying to promote. Our photos should 
be vibrant and reflective of our student 
body. The images you choose should be 
compelling and reflective of the energy 
that drives the Students’ Union and all of 
our activities.

Logos

If you are uploading our in-house 
photography onto facebook, make sure 
it includes the Students’ Union logo to 
ensure that students recognise our brand 
and the activities we have to offer. The 
Communications and Marketing team will 
be able to advise you on logo usage.
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www.qmsu.org/sport

1.11

Videography 
A well-made video can capture 
the essence of your project, 
event or campaign and 
bring it to life with emotional 
storytelling.

We have a range of campaigns and 
projects across the organisation, each 
with their own look and feel. Students’ 
Union videos should always have core 
brand elements such as our website and 
logo.

Text

A limited number of Cocogoose font 
licenses are available upon request. If you 
do not have access to Cocogoose, contact 
the Communications and Marketing team.

Interviewees

For videos with interviews, the bottom left 
or right corner should be used to identify 
interviewees. Make sure you write out our 
company name Queen Mary Students’ 
Union in full.

Outro

At the end of the video, always place the 
appropriate website link and Queen Mary 
Students’ Union logo. All campaign outro 
slides or animations should be designed 
by the Communications and Marketing 
team. Please contact them to request 
artwork.

Intro Interviewees

Outro for campaigns General Outro

Miranda Black
Queen Mary Students’ Union
President 2017-18

Welcome to your 
Students’ Union

NO TO FEE RISES, NO TO TEF

WWW.QMSU.ORG/BOYCOTT



16

How we soundHow we soundHow we soundHow we sound
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2.1

Our name 
Always ensure you refer to 
Queen Mary Students’ Union 
correctly.

Our full name

Our official full name is Queen Mary 
University of London Students’ Union. 
We mainly use this in legal documents.

When talking to students

For student-facing communications, 
in the first instance use Queen Mary 
Students’ Union and following this, 
use Students’ Union.

When talking to stakeholders

For communications aimed at those 
outside the University, in the first 
instance always use Queen Mary 
University of London Students’ Union. 
After the first reference, we should be 
referred to as the Students’ Union in 
the rest of the document. 

Use of ‘Union’

Use of ‘the Union’ should be avoided 
in official communications and minutes 
to avoid confusion with other unions 
on campus, including trade unions. We 
also want to highlight that we are run 
by students for students and students 
are always at the heart of everything 
that we do. 
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2.2

Our Values 
Our tone of voice should reflect our core 
ideas, personality and behaviour and 
guide what we are saying and how we 
say it.

When writing, always keep our values 
in mind. You do not need to incorporate 
every single value into what you 
write, but it is important our values 
are communicated in ways that are 
appropriate for your audience and the 
subject matter.

Supportive, inclusive & 
accessible

We speak to students, for students and 
do not use language that marginalises 
any group. Wherever possible, keep your 
writing simple by using short sentences 
and avoiding over-complicated language. 
Avoid using jargon, and ensure any 
acronyms are explained at the first 
point of use in brackets. You should also 
consider that jargon and acronyms can 
be difficult to understand if English is not 
somebody’s first language.

Our Values
  Student-led 
  Democratic
  Transparent

  Supportive
  Inclusive 
  Accessible

  Welcoming
  Fun
  Committed

Welcoming, fun & Committed

When appropriate, all communication 
should be friendly and student-focused 
to ensure students feel like we’re 
approachable. Write with an active rather 
than a passive voice, and write in the 
present tense when possible.

Student-led, democratic & 
Transparent

This is a university, if you are ever 
disingenuous students’ will know. Make 
sure your communications are honest 
and clearly based on what students have 
asked for.
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2.3

Your audience 
Know who you’re talking to

Before you write something, always be 
clear about who it is you’ll be speaking 
to and what you want them to know. 
You’ll often need to tailor your approach 
depending on the subject matter and the 
audience. 

Presume they know nothing

When writing communications to students,  
try and put yourself in their shoes. 
Many students will be reading about a 
campaign, project or event for the first 
time. Think about what key information 
you would need to know to get involved. 
Would you go to an event if you didn’t  
know where the event is or how much it 
might cost?

Research your audience

The Communications and Marketing 
team have a wealth of research from 
past surveys, focus groups and feedback 
sessions. Always refer back to past 
research to find out what is important to 
your audience. 
 
Choose the correct channel
Consider where your target audience 
will be. If you have a campaign aimed 
at students living in Halls of Residence, 
putting up posters in the Students’ Hub 
on the other side of campus probably is 
not the most effective way or reaching 
your audience. If you need help with 
this, please speak to a member of the 
Communications and Marketing team.
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3.1

Outlets and 
venues
Our bars, cafés, shops and 
Sport and Fitness Centres across 
our campuses have their own 
brands to distinguish them from 
other services on campus.

These are used alongside our main brand 
and are generally reserved for our outlets 
and venues which have a physical place 
on campus.
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3.2

Barts and 
The London 
Students’ 
Association
Students in the Barts and The 
London School of Medicine 
and Dentistry are members of 
both the Barts and The London 
Students’ Association (BLSA) and 
Queen Mary Students’ Union.

BLSA has its own set of representatives, 
societies and sports clubs, and its own 
building is home to a bar, games room, 
dance studio and the BLSA offices. 
Therefore, they have their own logo too.

Barts and The London students are 
also based in our Charterhouse Square 
campus in Central London, where you 
may also see this logo.

Pantone 425
CMYK - 60/51/51/20
RGB - 102/102/102
#666666

Black
CMYK - 0/0/0/100
RGB - 0/0/0
#000000
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3.3

Sub-brand 
Templates
We know there will be times 
in our outlets and venues that 
you will need to put up a quick 
notice to inform users of an 
issue or change.

All our outlets and venues have a 
template with editable placeholder text.

How to use the templates

• Download the template at:  
www.qmsu.org/communications/
brand

• Click View > Edit

• Add your text and print

Remember, don’t change the:

Colours / fonts / layout / style / logos

 

 

 
 

Drapers is 
booked for a 
private event 

 
Sorry for any  

inconvenience caused 

 

 

 
 

The Griff Inn is 
booked for a 
private event 

 
Sorry for any  

inconvenience caused 

 

 

 
 

This area is 
booked for a 
private event 

 
Sorry for any  

inconvenience caused 

 

 

 
 

This area is 
booked for a 
private event 

 
Sorry for any  

inconvenience caused 

 

 

 
 

This running 
machine is  
out of order 

 
Sorry for any  

inconvenience caused 

 

 

 
 

The Shield is 
booked for a 
private event 

 
Sorry for any  

inconvenience caused 

 

 

 
 

This fridge is 
out of order 

 
Sorry for any  

inconvenience caused 

 

 

 
 

This fridge is 
out of order 

 
Sorry for any  

inconvenience caused 
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3.4

New logos
We are Queen Mary Students’ 
Union and we want people to 
know how we are working to 
improve the lives of students at 
Queen Mary.

The best way to raise awareness of 
the work we do is to have the Students’ 
Union is to feature our logo and name 
on everything we produce. If every 
campaign, project or department had their 
own logos, the impact of the work we do 
would be diluted and students would be 
less likely to associate the great work we 
do with the Students’ Union.

Can I have a logo?

One of our biggest design requests is to 
produce a ‘logo’. As we mentioned above, 
the more logos we have, the less effective 
our messaging becomes. We will never 
produce new logos for any departments, 
however, we work hard to give each area 
or activity a ‘look and feel’.

Older sub-brands

Occasionally, we still find old versions of 
sub-brand logos that are no longer in use. 
If you spot any, let the Communications 
and Marketing team know and we can 
update these for you. 
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TemplatesTemplatesTemplatesTemplates
Part 4

Download the templates at:
www.qmsu.org/communications/brand
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4.1

Word 
Templates
Word document templates 
help ensure your documents 
represent the Students’ Union 
professionally and consistently.

You should use these templates for 
any and all documents you produce, 
whether on or off campus, when you are 
representing the Students’ Union.

Everyday Document

Used for meeting notes, agendas, 
minutes, guidelines and projects plans. 

Letterhead

Used for official documentation featuring 
our contact details including job 
offers, supplier contracts, stallholder 
confirmations and disciplinary documents.

Report

Used for Presidents’ reports, Departmental 
reports,  Senate reports, Student Council 
reports, Board of Trustees reports.

Remember, don’t change the:

Colours / fonts / layout / style / logos

Everyday document Official Letterhead

 

 
1 

How to use this word document 

Making a professional word document 

How to change the text styles 
You can change text styles using the ‘Styles Pane’ section of word. Ask Marketing if you can’t find it 
or you are unsure on how to use it, but basically the text should look like this page. Here’s a few hints 
and tips for using text styles: 

• Use the styles provided 

• Avoid changing fonts, colours or sizes of the text 

• Section your document with titles and subtitles to make it easier to read 

• Don’t make lots of words bold, underlined or italic. The more you highlight a document in this 
way the less the important words stand out. Give emphasis to only the most important words. 
Insert a heading here 

How to sound more like Queen Mary Students’ Union 
We have a set of brand guidelines to help you to look and sound like Queen Mary Students’ Union 
on www.qmsu.org/communications/brand but here’s a quick summary: 

• Always refer to us as Queen Mary Students’ Union in the first instance, then you can use 
Students’ Union later in the document. 

Why is this important? 
Our word documents are used by all staff to communicate messages to our students and 
stakeholders so they are really important to give a great first impression. A professional looking word 
document will automatically make your messages seem more legitimate and build trust with your 
audience. 

 

 

 
 
 
 
 
 
 

 

Name 
Address line 1 
Address line 2 

London 
Postcode 

Email 
Phone 

Dear insert name here, 
your main body of text here. Write your main body of text here. Write your main body of text here. 
Write your main body of text here. 

Write your main body of text here. Write your main body of text here. Write your main body of text 
here. Write your main body of text here. Write your main body of text here. 

Insert a sub-heading here 
Write your main body of text here. Write your main body of text here. Write your main body of text 
here. Write your main body of text here. Write your main body of text here. Write your main body of 
text here. Write your main body of text here. Write your main body of text here. Write your main 
body of text here. Write your main body of text here. 

Write your main body of text here. Write your main body of text here. Write your main body of text 
here. Write your main body of text here. Write your main body of text here. Write your main body of 
text here. Write your main body of text here. Write your main body of text here. Write your main 
body of text here. Write your main body of text here. 

Write your main body of text here. Write your main body of text here. Write your main body of text 
here. Write your main body of text here. Write your main body of text here. Write your main body of 
text here. Write your main body of text here. Write your main body of text here. Write your main 
body of text here. Write your main body of text here. 

Write your main body of text here. Write your main body of text here. Write your main body of text 
here. Write your main body of text here. Write your main body of text here. Write your main body of 
text here. Write your main body of text here. Write your main body of text here. Write your main 
body of text here. Write your main body of text here. 

Write your main body of text here. Write your main body of text here. Write your main body of text 
here. Write your main body of text here. Write your main body of text here. Write your main body of 
text here. Write your main body of text here. Write your main body of text here. Write your main 
body of text here. Write your main body of text here. 

Insert a sub-heading here 
Write your main body of text here. Write your main body of text here. Write your main body of text 
here. Write your main body of text here. Write your main body of text here. Write your main body of 
text here. Write your main body of text here. Write your main body of text here. Write your main 
body of text here. Write your main body of text here. 

Write your main body of text here. Write your main body of text here. Write your main body of text 
here. Write your main body of text here. Write your main body of text here. Write your main body of 

Download at: qmsu.org/communications

Report

 

  

Insert your document title here 
Your department 
February 2018 
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Handbook with Exec 
(recommended)

 

 

 

  

Insert your document title here 
Queen Mary Students’ Union 
February 2018 

4.2

Handbooks
Templates help to ensure 
your document represents the 
Students’ Union’s values.

If you are producing student-facing 
booklets such as course-rep handbooks, 
guides for societies or introductions to 
your department, these are the templates 
for you!

Why include the Executive 
Officers?

The Students’ Union is run for students by 
students, so it is important that we profile 
our elected officers where possible. They 
may not have personally helped you 
create your handbook, but they are the 
face of our organisation and all the work 
we produce.

...but the Executive Officers 
change every year and I don’t 
want to update my whole 
document

For old documents, we will make a new 
first page available for download so you 
just need to replace the cover image each 
year.

Remember, don’t change the:

Colours / fonts / layout / style / logos

 

  

Insert your document title here 
Queen Mary Students’ Union 
February 2018 

Handbook Plain

Download at: qmsu.org/communications
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Activity template

 

Find out more at: www.qmsu.org/insertweblinkhere 
 

Big Breakfast Challenge  
 

Add a really friendly and inviting 
description of your event here. To 
change the image right click on the 
image and select ‘Change Picture’. 
Then Right click on the image and 
select ‘Crop’. Change the crop of 
the image so it is the same shape as 
the original. Any questions please ask 
Marketing. 
 
Time: 

Fridays 4pm - 5pm 

Venue: 

Qmotion Sports Hall 

Cost: 

£2.50 

 
 
 
 
 
 
 

 

4.3

Get Involved Boards
To make it easier for staff to promote their 
staff-led events or student staff jobs, we 
have produced an editable work document. 

How do I use it?

• Download the template from: 
www.qmsu.org/communications/brand

• Click ‘Enable editing’ to use. 

Where can I add them?

You can add them to the get involved boards in Qmotion, 
the Hub, BLSA, and The Nest. Remove any out-of-date 
events and prioritise the most imminent event. If there is 
not space for your event, put your template behind an 
event ending soon so it is ready to be replaced.

Which events can I promote?

The Get Involved boards are for staff-led events, for 
example; Volunteering, Sustainability, Crafternoons and 
Trips and Tours. These events don’t each need individual 
brands and you can use the same image on these as you 
do to promote the events on social media.

Can I add my other posters?

We want these boards to be easy to read and neat 
and tidy so please do not add anything other than this 
template into these boards. There are specific poster 
frames in the Hub, Drapers, the Multi-Faith Centre, 
the Nest and around campus for individually branded 
posters.

Remember, don’t change the:

Colours / fonts / layout / style / logos

 

 

Find out more at: www.qmsu.org/jobs 
 

Drapers: Venues Student Staff 
 

To work as a bartender and bar back 
at both Griff Inn and Drapers, our staff 
will ensure the venue runs smoothly by 
working in a team to deliver high 
standards of service to customers. They 
will also promote events and activities 
run by the Students' Union; inspiring 
interest and encouraging students to 
take part. 
 
Deadline: 

Friday 30 March 2018, 5pm 

Hours: 

Flexible hours (approx 12 hours pw) 

Rate: 

£11.79 per hour (Including holiday pay) 

Benefits: 
• Free gym membership* 
• 20% off at all Students’ Union outlets* 
• Free entry to some QMSU events* 
• Professional training & qualifications 
 

Student staff  
recruitment template

Download at: qmsu.org/communications
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Opening hours

 

 

The Nest 
opening hours 
 
Monday 9am - 9.30pm 

Tuesday 9am - 9.30pm 

Wednesday 9am - 9.30pm 

Thursday 9am - 9.30pm 

Friday 3pm - 9.30pm 

Saturday 9am - 9.30pm 

Sunday 9am - 9.30pm 

 

 

These toilets 
are closed. 
 
You can find additional toilets on 
the first floor of this building. Sorry 
for any inconvenience caused. 

General notices

Download at: qmsu.org/communications

Room schedules

 

 

Blomeley room 1 
26th September 2018 
 
9am – 10am Hindu Society meet and greet 

10am – 11am Amnesty International Meet and Greet 
your new society 

11.30am – 12.30pm Staff booking 

12.30pm – 1pm Get Active: Table Tennis 

1pm-3pm Staff booking 

3pm – 4pm 
Table > Insert > Row Below 
Table > Delete > Rows 

 

4.4

Notices
These notices are to be used for 
services that are out of order, 
room bookings and general 
housekeeping notices.

We are a Students’ Union and some of our 
values are fun, welcoming, supportive, 
accessible and student-led. We need 
to make sure all of our communications  
reflect our values, even our notices. 

Here’s a few tips:

• Don’t use all CAPS

• Don’t use exclamation marks

• Don’t change the fonts, sizes or 
colours

• Apologise for any inconvenience 
caused

• If a service is out of order, make sure 
you direct students to the nearest 
alternative services where possible.

• Make sure the problem is clear and 
easy to understand.
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4.5

Powerpoint 
Templates
PowerPoint templates help 
ensure your presentations 
represent the Students’ Union 
professionally and consistently.

You should use these templates for 
any and all presentations you give, 
whether on or off campus, when you are 
representing the Students’ Union.

Are there variations?

There are over 40 different templates 
to use within the powerpoint document 
so there will be something for every 
presentation.

Why include the Exec?

The Students’ Union is run for students by 
students, so it is important that we profile 
our elected officers where possible. They 
may not have personally helped you 
create your handbook, but they are the 
face of our organisation and all the work 
we produce.

Remember, don’t change the:

Colours / fonts / layout / style / logos

Download at: qmsu.org/communications

Insert name of presentation here

Name of presenter(s) or departments

How to add new slides
Click ’Insert’ > ‘New slide’

• There are lots of slides to suit all presentations. Use as many or as little as you need.
• If your presentation is short then only use the slides from section one. 
• If your presentation is long then use section slides to section your presentation.
• For consistency keep the background images the same in each section, don’t use different 

colour backgrounds for each slide.
• Delete these introduction slides afterwards.

• We want to promote our executive officers as much as possible. If you are doing a student facing 
presentation please use the image of the exec as the intro slide. If it really isn’t appropriate there is one 
with the mission statement. We will send you a new slide with the new exec each year to avoid you 
having to re-do the whole presentation.

2

Welcome to your Powerpoint document

Insert name of 
presentation here

Name of presenter(s) or departments

How to add new slides
Click ’Insert’ > ‘New slide’

• There are lots of slides to suit all presentations. Use as many or as little as you need.
• If your presentation is short then only use the slides from section one. 
• If your presentation is long then use section slides to section your presentation.
• For consistency keep the background images the same in each section, don’t use different 

colour backgrounds for each slide.
• Delete these introduction slides afterwards.

• We want to promote our executive officers as much as possible. If you are doing a student facing 
presentation please use the image of the exec as the intro slide. If it really isn’t appropriate there is one 
with the mission statement. We will send you a new slide with the new exec each year to avoid you 
having to re-do the whole presentation.

2

Welcome to your Powerpoint document

General Corporate
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Every email you send is an opportunity 
to raise awareness of the Students’ 
Union and create a sense of trust and 
professionalism. Think of an email 
signature as a digital business card; it 
needs to be well designed, professional, 
conform to brand guidelines and 
provide only the most important contact 
information. Any variations or additions 
should be agreed by the Communications 
and Marketing team.

How to set an email signature

1. Download a copy of the email signature: 
www.qmsu.org/communication/brand

2. Open in word and follow the 
instructions.

Can I add my own campaign?

Email signature campaigns should 
be reserved for Students’ Union-
wide campaigns provided by the 
Communications and Marketing team 
only, such as elections. The email 
signature is not the place to promote your 
individual campaigns, projects, initiatives, 
Favourite GIFs or chosen charitable 
messages.

4.6

Email Signatures
Every email that comes from the Students’ Union reflects 
upon the organisation. Using one simple, branded 
email signature helps strengthen our visual identity. 

Can I edit my email signature?

Follow these guidelines to ensure the best 
formatting and best usage of your email 
signature. For consistency:

• Do not resize the logo image

• Do not add anything to the signature, 
such as inspirational quotes, text or 
additional graphics.

• Do not change the colours, sizes or 
typefaces of the text.

Gender Pronouns

Including gender pronouns is a basic way 
to respect a person’s gender identity. When 
someone is referred to with a pronoun 
(e.g. he/she/they) that doesn’t align with 
their gender identity, it can make them 
feel alienated. If you would like to include 
it, please delete from the options as 
appropriate or add your own.

Working on other campuses,  
part-time hours or with BLSA.

There are additional options to add these 
into the email signature. If you work part-time 
hours please either set an out-of-office for 
the day(s) that you do not work and direct 
people to the correct person or add a line of 
text above the print message. If you have two 
phone numbers throughout the week please 
add the days next to each phone number.

Download at: qmsu.org/communications
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The Students’ Union is committed to 
providing a high level of customer service 
to our students and stakeholders and we 
want every student to feel valued. When 
out of the office, it is a good idea to let 
people know that you are not available 
and give them another person they can 
contact in your absence.

How to set an out of office or 
auto-reply

1. Download a copy of the out of office: 
www.qmsu.org/communication/brand

2. Open in word and follow the 
instructions.

An out of office message should 
only be used when:

1. You are out of the office

2. Your absence is for one day or more. 
You do not need to set out of offices for 
just a few hours.

3. Your response is useful to the recipient. 
State when you are away, give a contact 
name for urgent queries and direct them 
online for more information if necessary.

4. Avoid specifying the reason you 
are away. Do not advertise a heavy 
workload, staffing issues or busy 
periods.

4.7

Out of Offices
Every email that comes from the Students’ Union reflects upon the organisation, 
even our out of office and auto-reply notifications. Using a simple, consistent 
template helps to give a good impression whilst managing expectations. 

...but I am really busy / short 
staffed / in lots of meetings and 
I wont be able to reply straight 
away so I want to set an out of 
office to let them know

All members of staff will go through these 
issues at some point but it is not good 
practice to have an out of office email set 
for long periods of time with no alternative 
contact option. Having an out of office that 
says that you are busy throughout October, 
or for the foreseeable future is giving 
students a very poor impression of the 
Students’ Union and our level of customer 
service. It also gives them no idea if, or 
when, you will reply to them or offers them 
alternative support to resolve their enquiry.

If the response time of your emails is 
falling behind for long periods of time then 
discuss this with your manager as soon as 
possible. If you still need to set an out of 
office due to busy periods, keep in mind 
that students do not need a list of your 
team’s current issues but they do need to 
know:

• When you will reply

• Who can they contact in the meantime 
or for urgent enquiries

• Where they can find useful information

Download at: qmsu.org/communications

Customer service auto-replies 
on shared inboxes
We should all try to keep our email support 
personal and timely enough to not warrant 
using auto-replies, but we understand that 
with our student-facing shared inboxes 
it may be important that you manage 
students expectations for response times if 
you are unable to reply swiftly. 

In most cases, your auto-reply is the first 
time a customer will ever receive an email 
from the Students’ Union so it’s really 
important we give a great first impression 
and give them useful information clearly 
and concisely. We have set up a template 
for you to edit and use in these instances. 
As a guide, every auto-reply should:

1. Acknowledge the request was received

2. Make it clear when they can expect a 
response

3. Offer an alternative contact for more 
support

4. Add links to relevant help articles or 
other ways they can self-troubleshoot
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4.8

Uniforms, 
T-shirts and 
hoodies
If you walk around campus , 
you will see lots of our staff 
and volunteers wearing our 
branded tops. We want to make 
sure everyone knows they are 
part of the Students’ Union. 

We want the uniforms to be consistent, 
so always ask the Communications and 
Marketing team for the latest design and 
for advice before ordering. We can set-up 
an artwork file to send to your suppliers.

Logos and artwork

The Communications and Marketing team 
will be able to supply the correct format 
logo for you to send to your supplier. For 
campaign and promotional clothing, you 
may also want to include your campaign 
or project’s visual identity.

Choosing Colours

In most cases, we use a white logo on 
a fabric colour from our palette. Each 
department or project will have a specific 
colour attached to it and Communications 
and Marketing can help you to select the 
exact colour values you need to make 
sure your supplier gets the colour perfect.

Staff uniformsCampaign T-shirts and Hoodies

www.qmsu.org/ahm

Staff

www.qmsu.org

Supervisor Fitness 
Instructor

Elected Officers T-shirts

Tom Longbottom
President

www.qmsu.org

Staff uniforms with limited edition campaigns

Staff

qmsu.org/zerotolerance
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Merchandise are freebies to give away or 
items that we sell in our outlets, including 
pens, notepads, reusable mugs, keyrings 
and tote bags. All merchandise should be 
checked with the Communications and 
Marketing team to ensure the branding is 
correct and whether any other departments 
are giving out similar items. Students don’t 
need seven free Oyster Card holders or 
pens at our Welcome Fair!

Choosing Colours

In most cases, we use a white logo on 
a colour from our colour palette. Each 
department or project has a specific colour 
attached to it and Communications and 
Marketing can tell you the exact colour 
values you will need to make sure your 
supplier gets the colour spot on. Don’t go 
off-piste and choose a random colour.

Multiple Logos

Nobody wants a free pen that has ten logos 
on it. The most important message for us 
to get across is that we are the Students’ 
Union, so wherever possible we should 
always use the Students’ Union logo and 
pair it with some artwork from your specific 
department or campaign.

4.9

Merchandise
Giving away or selling merchandise 
is a great and fun way to get your 
message to students’ and tell them 
more about their Students’ Union.
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4.10

Table cloths 
and gazebos
We are a vibrant campus with 
lots of events and activities 
taking place on our campuses 
everyday. We want to make it 
clear which activities are run by 
the Students’ Union by branding 
all of our stalls and events.

In most cases, we use the Queen Mary 
Students’ Union logo in white on our 
brand blue fabric. By using one consistent 
brand, we can make it clear to students 
which events and activities are run by the 
Students’ Union.

Can I brand them 
with my own campaign?

If you are using a gazebo or table cloth for 
a one off event or an event that happens 
only a few times a year, getting your own 
gazebo is not sustainable or cost effective 
for the Students’ Union.

We want to make it clear which activities 
on our large and varied campus are part 
of the Students’ Union and by having 
numerous brands using different artwork 
and logos we cannot achieve this. 

We recommend that you always get 
gazebos and tablecloths in the main 
Students’ Union branding and share these 
items between departments.


